Instruction Guide
for using the
Pavement Asset Management Plan Template
Contents

Saving the template files on your computer.............................................................................. 1

Exporting data from Roadsoft..................................................................................................... 2

Preparing to export files............................................................................................................... 2

1. Export AM Plan Base (Agency Type) – SurfTwp.csv................................................................. 3
2. Export AM Plan Base (Agency Type) – Act51Twp.csv.............................................................. 7
3. Export AM Plan Base (Agency Type) + On NHS – Act51TwpNHS.csv ................................... 9
4. Export AM Plan Base (Agency Type) + Paved, Group by Legal System – LatestSurfSum.csv .... 11
5. Export AM Plan Base (Agency Type) + Paved, Group by City/Twp – LatestSurfSumTwp.csv .... 14
7. Export AM Plan Base (Agency Type) + Paced – RtgSumRange.csv .......................................... 18
8. Export AM Plan Base (Agency Type) + Unpaved – LatestIBRSum.csv .................................... 20

Reviewing the eight export files .................................................................................................. 23

Entering data into the Excel workbook......................................................................................... 24

Using the XLSM file for the first time............................................................................................ 24

Welcome Worksheet.................................................................................................................... 25

Questionnaire Worksheet............................................................................................................. 26

userdata1, userdata2, and userdata3 Worksheets .......................................................................... 31

Charts Worksheet.......................................................................................................................... 37

Completing the Word template .................................................................................................... 39

Customizing the Word template.................................................................................................. 45

Inserting a logo............................................................................................................................ 45

Changing the color bar (Optional)............................................................................................... 46

Changing color of Cover and Heading 1 Styles (Optional) .......................................................... 47

Inserting charts (manual procedure) .......................................................................................... 50

Inserting images.......................................................................................................................... 50

Creating map images from Roadsoft ......................................................................................... 52

Creating image for 1. Pavement Assets > Inventory of Assets (Figure 16) ................................. 52

Creating image for 1. Pavement Assets > Planned Projects (Figures 44 – 50) ......................... 60

Creating image for 3. Risk of Failure Analysis (Figure 54)........................................................ 66

Creating images from PDF files ................................................................................................. 74

Updating the Table of Contents, Table of Figures, and Table of Tables ....................................... 76

Inserting Appendixes .................................................................................................................. 81

Updating in Future Years............................................................................................................. 83

© 2019 Center for Technology & Training. All rights reserved.
Prepared on behalf of the Michigan Transportation Asset Management Council.
This document provides instruction for creating a personalized pavement asset management plan for your specific agency by using the “DataMacro_pavementAMP_v2019.xlsm” and “pavementAMP_v2019.docm”, distributed to you by the Center for Technology & Training in collaboration with the Transportation Asset Management Council and the Michigan Department of Transportation. Pavement asset data for your agency will need to be exported from Roadsoft or compiled manually and entered into the macro-enabled workbook. This workbook will then parse the data for the Microsoft Word template. This Instruction Guide will detail how to enter asset data into the Excel workbook and, subsequently, generate a pavement asset management plan in Word.

**Saving the template files on your computer**

The two template files for creating a pavement asset management plan will be provided to you on a USB drive. **Do not rename these. Also, these files must be saved in the same folder along with the necessary Roadsoft exports.** It is recommended that a new subfolder be created in your Documents or My Documents folder, or a new folder be created on your desktop. This new (sub)folder should be given a unique name, such as “PavementAMP-2020”. The .xlsm, and the .docm files, as well as the .csv files if Roadsoft is your modelling/forecasting tool, should be saved in that new (sub)folder. It is also recommended that any other content needed for your pavement asset management plan—such as logos and images—be kept in this folder, as well.
Exporting data from Roadsoft

These instructions for the current version of Roadsoft (2019.10 or newer) detail the process of exporting the eight required Roadsoft .csv files for the Excel pavement asset management plan workbook. All eight files are required to run the workbook steps. All export files must be saved within the same folder as the workbook and the Word template, and the file names must have the same names as provided in the instructions.

**NOTE:** All eight files should be exported even if there is no corresponding data since the workbook requires all eight .csv files to run.

**Preparing to export files**

1. Create/locate the new folder you created on your hard drive for storing your pavement asset management plan files.

2. Launch the Roadsoft desktop application.

3. Select the TMC menu (see figure below).

4. Select **Asset Management Reporting**… from the TMC menu (see figure below).
A window will open called *Road Reports* (see figure below).

**NOTE:** All eight exports are created in the *Road Reports* window using the following steps. If the window closes at any time during the following steps, repeat the preceding steps 3 and 4 to reopen the *Road Reports* window.

1. **Export AM Plan Base (Agency Type) – SurfTwp.csv**
   1. Change the report name in the *Road Reports* window from the default to **Surface Type Mileage by Jurisdiction** (see figure below).
2. Change the Mileage Type to either **Centerline** or **Lane** from the dropdown list in the *Report Options* section of the *Road Reports* window (see figure below).

![Image](image.png)

**NOTE:** The mileage type (i.e., centerline or lane) will only need to be selected once; this choice will remain the same for the remaining exports.

3. Load the *AM Plan Base* saved filter.

   a. Select **Open** in the *Filter Builder* section of the *Road Reports* window (see figure below).

   ⇒ The *Load Saved Filter* window will open.

   b. Select **AM Plan Template** from the *Group:* dropdown list of the *Load Saved Filter* window (see figure below).

   c. Select **AM Plan Base (City)** or **AM Plan Base (County)** from the listed filters based on your agency type (see figure below).

   d. Select **OK** (see figure below).

   ⇒ The saved filter will load into the *Road Reports* window.
Select Jurisdiction Type or Legal System to highlight the field and to access/change the operator and/or value(s) (see figure below).

The available operators and values will appear in the Road Reports window (see figure below).
5. Select **Export** in the **Road Reports** window (see figure above).

⇒ The **Export Report Data to File** window will open (see figure below).

6. Select **Export** in the **Export Report Data to File** window (see figure below).

⇒ The **Save file to CSV File** window will open with the **File name** field populated as “SurfTwp.csv” (see figure below).

**NOTE:** If no data is generated, the file must still be exported and saved.

7. Navigate in the **Save file to CSV File** window to the folder you created for your pavement asset management plan materials (see figure below).
8. Select **Save**.

   A window will appear confirming the file export location.

9. Select **OK**.


### 2. Export AM Plan Base (Agency Type) – Act51Twp.csv

1. Change the report name in the *Road Reports* window to **Legal System Mileage by Jurisdiction** (see figure below).

2. Change the mileage type to **Centerline** or **Lane** (refer to 1. *Export AM Plan Base...SurfTwp.csv* step 2 for figure).

3. Load the *AM Plan Base* saved filter.
   a. Select **Open** in the *Filter Builder* section of the *Road Reports* window (refer to 1. *Export AM Plan Base...SurfTwp.csv* step 3 for figure).
The Load Saved Filter window will open.

b. Select AM Plan Template from the Group: dropdown list of the Load Saved Filter window (refer to 1. Export AM Plan Base...SurfTwp.csv step 3 for figure).

c. Select AM Plan Base (City) or AM Plan Base (County) from the listed filters based on your agency type (refer to 1. Export AM Plan Base...SurfTwp.csv step 3 for figure).

d. Select OK (refer to 1. Export AM Plan Base...SurfTwp.csv step 3 for figure).

The saved filter will load into the Road Reports window.

4. Select Jurisdiction Type or Legal System to highlight the field and to access/change the operator and/or value(s) (refer to 1. Export AM Plan Base...SurfTwp.csv step 4 for figure).

The available operators and values will appear in the Road Reports window (refer to 1. Export AM Plan Base...SurfTwp.csv step 4 for figure).

5. Select Export in the Road Reports window.

The Export Report Data to File window will open (refer to 1. Export AM Plan Base...SurfTwp.csv step 6 for figure).


The Save file to CSV File: window will open with the File name field populated as “Act51Twp.csv” (see figure below).

NOTE: If no data is generated, the file must still be exported and saved.

7. Navigate in the Save file to CSV File: window to the folder you created for your pavement asset management plan materials (see figure below).
8. Select Save (see figure below).

.fileName.png

A window will appear confirming the file export location.

9. Select OK.


3. Export Plan Base (Agency Type) + On NHS – Act51TwpNHS.csv

1. Change the report name in the Road Reports window to Legal System Mileage By Jurisdiction (see figure below).

2. Change the Mileage Type to either Centerline or Lane from the dropdown list in the Report Options section of the Road Reports window (refer to 1. Export AM Plan Base…SurfTwp.csv step 2 for figure).

3. Load the AM Plan Base saved filter.

   a. Select Open in the Filter Builder section of the Road Reports window (see figure below).

      ➜ The Load Saved Filter window will open.
b. Select **AM Plan Template** from the *Group:* dropdown list of the *Load Saved Filter* window (see figure below).

c. Select **AM Plan Base (City) + NHS** or **AM Plan Base (County) + NHS** from the listed filters based on your agency type (see figure below).

d. Select **OK.**

⇒ The saved filter will load into the *Road Reports* window.

![Filter Builder Window](image)

4. Select **On National Hwy System** to highlight the field and to access/change the operator and/or value(s) (see figure below).

![Field Operator and Value Selection](image)

⇒ The available operators and values will appear in the *Road Reports* window.

5. Select **Export** in the *Road Reports* window.

⇒ The *Export Report Data to File* window will open.


⇒ The *Save file to CSV File:* window will open with the *File name* field populated as “Act51TwpNHS.csv” (see figure below).
**NOTE:** If no data is generated, the file must still be exported and saved.

7. Navigate in the *Save file to CSV File:* window to the folder you created for your pavement asset management plan materials (see figure below).

8. Select **Save** (see figure below).

![Save file to CSV File window](image)

- A window will appear confirming the file export location.

9. Select **OK**.


---

### 4. Export AM Plan Base (Agency Type) + Paved, Group by Legal System – LatestSurfSum.csv

1. Change the report name in the *Road Reports* window from the default to **Latest PASER Rating Mileage Summary** (see figure below).

![Road Reports window](image)

2. Change the *Mileage Type:* to either **Centerline** or **Lane** from the dropdown list in the *Report Options* section of the *Road Reports* window (refer to 1. Export AM Plan Base...SurfTwp.csv step 2 for figure).
3. Change the Group By to **Legal System** from the dropdown list in the Report Options section of the Road Reports window (see figure below).

![Report Options screenshot](image1)

4. Load the AM Plan Base saved filter.
   a. Select **Open** in the Filter Builder section of the Road Reports window (see figure below).
      - The Load Saved Filter window will open.
   b. Select **AM Plan Template** from the Group: dropdown list of the Load Saved Filter window (see figure below).
   c. Select **AM Plan Base (City) + Paved** or **AM Plan Base (County) + Paved** from the listed filters based on your agency type (see figure below).
   d. Select **OK** (see figure below).
      - The saved filter will load into the Road Reports window.

![Load Saved Filter screenshot](image2)
5. Select **Jurisdiction Type** to highlight the field and to access/change the operator and/or value(s) (see figure below).

<table>
<thead>
<tr>
<th>Group</th>
<th>Field</th>
<th>Operator</th>
<th>Values(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Jurisdiction Type</td>
<td>=</td>
<td>Township</td>
</tr>
<tr>
<td></td>
<td>Legal System</td>
<td>=</td>
<td>1=County Primary or 3=County Local</td>
</tr>
<tr>
<td></td>
<td>Surface Type</td>
<td>=</td>
<td>Asphalt or Black or Concrete or Seal Coat</td>
</tr>
</tbody>
</table>

⇒ The available operators and values will appear in the *Road Reports* window.

6. Select **Export** in the *Road Reports* window.

⇒ The *Export Report Data to File* window will open.

7. Select **Export** in the *Export Report Data to File* window.

⇒ The *Save file to CSV File:*, window will open with the *File name* field populated as “LatestSurfSum.csv” (see figure below).

**NOTE:** If no data is generated, the file must still be exported and saved.

8. Navigate in the *Save file to CSV File:*, window to the folder you created for your pavement asset management plan materials (see figure below).

9. Select **Save** (see figure below).

⇒ A window will appear confirming the file export location.

10. Select **OK**.

5. Export AM Plan Base (Agency Type) + Paved, Group by City/Twp – LatestSurfSumTwp.csv

1. Change the report name in the Road Reports window to Latest PASER Rating Mileage Summary (see figure below).

2. Change the Mileage Type to either Centerline or Lane from the dropdown list in the Report Options section of the Road Reports window (refer to 1. Export AM Plan Base…SurfTwp.csv step 2 for figure).

3. Change the Group By to City/Twp from the dropdown list in the Report Options section of the Road Reports window (see figure below).

4. Load the AM Plan Base saved filter.
   a. Select Open in the Filter Builder section of the Road Reports window (refer to 4. Export AM Plan Base…LatestSurfSum.csv step 4 for figure).

      ⇒ The Load Saved Filter window will open.


   c. Select AM Plan Base (City) + Paved or AM Plan Base (County) + Paved from the listed filters based on your agency type (refer to 4. Export AM Plan Base…LatestSurfSum.csv step 4 for figure).

5. Select **Jurisdiction Type** to highlight the field and to access/change the operator and/or value(s) (see figure below).

6. Select **Export** in the Road Reports window.

7. Select **Export** in the Export Report Data to File window.

8. Navigate in the Save file to CSV File: window to the folder you created for your pavement asset management plan materials (see figure below).

9. Select **Save** (see figure below).

10. Select **OK**.


1. Change the report name in the Road Reports window to Latest PASER Rating Mileage Summary (see figure below).

   ![Report Name](image)

2. Change the Mileage Type to either Centerline or Lane from the dropdown list in the Report Options section of the Road Reports window (refer to 1. Export AM Plan Base...SurfTwp.csv step 2 for figure).

3. Change the Group By to Legal System from the dropdown list in the Report Options section of the Road Reports window (refer to 4. Export AM Plan Base...LatestSurfSum.csv step 3 for figure).

4. Load the AM Plan Base saved filter.
   a. Select Open in the Filter Builder section of the Road Reports window (see figure below).
      ⇨ The Load Saved Filter window will open.
   b. Select AM Plan Template from the Group: dropdown list of the Load Saved Filter window (see figure below).
   c. Select AM Plan Base (City) + On NHS or AM Plan Base (County) + On NHS from the listed filters based on your agency type (see figure below).
   d. Select OK (see figure below).
      ⇨ The saved filter will load into the Road Reports window.
5. Select **On National Hwy System** to highlight the field and to access/change the operator and/or value(s) (see figure below).

- The available operators and values will appear in the *Road Reports* window.

6. Select **Export** in the *Road Reports* window.

- The *Export Report Data to File* window will open.

7. Select **Export** in the *Export Report Data to File* window.

- The *Save file to CSV File:* window will open with the *File name* field populated as “LatestSurfSumNHS.csv” (see figure below).

**NOTE:** If no data is generated, the file must still be exported and saved.

8. Navigate in the *Save file to CSV File:* window to the folder you created for your pavement asset management plan materials (see figure below).

9. Select **Save** (see figure below).
A window will appear confirming the file export location.

10. Select **OK**.

11. Close the **Export Report Data to File** window.

7. Export AM Plan Base (Agency Type) + Paced – RtgSumRange.csv

1. Change the report name in the **Road Reports** window to **Surface Rating Mileage Summary for a Range of Years** (see figure below).

2. Change the **Mileage Type** to either **Centerline** or **Lane** from the dropdown list in the **Report Options** section of the **Road Reports** window (refer to 1. Export AM Plan Base...SurfTwp.csv step 2 for figure).

3. Change the **Group By** to **Legal System** from the dropdown list in the **Report Options** section of the **Road Reports** window (refer to 4. Export AM Plan Base...LatestSurfSum.csv step 3 for figure).

4. Load the **AM Plan Base** saved filter.
a. Select **Open** in the *Filter Builder* section of the *Road Reports* window (refer to 4. *Export AM Plan Base...LatestSurfSum.csv* step 4 for figure).

⇒ The *Load Saved Filter* window will open.

b. Select **AM Plan Template** from the *Group:* dropdown list of the *Load Saved Filter* window (refer to 4. *Export AM Plan Base...LatestSurfSum.csv* step 4 for figure).

c. Select **AM Plan Base (City) + Paved** or **AM Plan Base (County) + Paved** from the listed filters based on your agency type (refer to 4. *Export AM Plan Base...LatestSurfSum.csv* step 4 for figure).

d. Select **OK** (refer to 4. *Export AM Plan Base...LatestSurfSum.csv* step 4 for figure).

⇒ The saved filter will load into the *Road Reports* window.

5. Select **Jurisdiction Type** to highlight the field and to access/change the operator and/or value(s) (see figure below).

<table>
<thead>
<tr>
<th>Group</th>
<th>Field</th>
<th>Operator</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jurisdiction Type</td>
<td>=</td>
<td>Township</td>
</tr>
<tr>
<td>2</td>
<td>Legal System</td>
<td>Or</td>
<td>County Primary or County Local</td>
</tr>
<tr>
<td>3</td>
<td>Surface Type</td>
<td>Or</td>
<td>Asphalt or Brick or Concrete or Seal Coat</td>
</tr>
</tbody>
</table>

⇒ The available operators and values will appear in the *Road Reports* window.

6. Select **Export** in the *Road Reports* window.

⇒ The *Export Report Data to File* window will open.

7. Select **Export** in the *Export Report Data to File* window.

⇒ The *Save file to CSV File:* window will open with the *File name* field populated as “RtgSumRange.csv” (see figure below).

**NOTE:** If no data is generated, the file must still be exported and saved.

8. Navigate in the *Save file to CSV File:* window to the folder you created for your pavement asset management plan materials (see figure below).

9. Select **Save** (see figure below).
A window will appear confirming the file export location.

10. Select OK.


8. Export AM Plan Base (Agency Type) + Unpaved – LatestIBRSum.csv

**NOTE:** If the agency does not have IBR ratings for unpaved roads but does have PASER ratings for unpaved roads, choose the Report Name of Latest PASER Mileage Summary and the AM Plan Base saved filter of the AM Plan Base (Agency Type) + Unpaved. Use the Group by selection of City/Twp and save as the file name “LatestIBRSum.csv”.

**NOTE:** Still complete the IBR export if your agency does not have unpaved roads or does not have unpaved road ratings.

1. Change the report name in the Road Reports window to Latest Inventory Based Rating (IBR) Mileage Summary (see figure below).
2. Change the Mileage Type to either Centerline or Lane from the dropdown list in the Report Options section of the Road Reports window (refer to 1. Export AM Plan Base...SurfTwp.csv step 2 for figure).

3. Change the Group By to City/Twp from the dropdown list in the Report Options section of the Road Reports window (refer to 5. Export AM Plan Base...LatestSurfSumTwp.csv step 3 for figure).

4. Load the AM Plan Base saved filter.
   a. Select Open in the Filter Builder section of the Road Reports window (see figure below).
      ⇒ The Load Saved Filter window will open.
   b. Select AM Plan Template from the Group: dropdown list of the Load Saved Filter window (see figure below).
   c. Select AM Plan Base (City) + Unpaved or AM Plan Base (County) + Unpaved from the listed filters based on your agency type (see figure below).
   d. Select OK (see figure below).
      ⇒ The saved filter will load into the Road Reports window.
5. Select **Jurisdiction Type** to highlight the field and to access/change the operator and/or value(s) (see figure below).

<table>
<thead>
<tr>
<th>Group</th>
<th>Field</th>
<th>Operator</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jurisdiction Type</td>
<td>Township</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legal System</td>
<td>Township</td>
<td></td>
<td>Township</td>
</tr>
<tr>
<td>Surface Type</td>
<td>Township</td>
<td></td>
<td>Township</td>
</tr>
</tbody>
</table>

⇒ The available operators and values will appear in the *Road Reports* window.

6. Select **Export** in the *Road Reports* window.

⇒ The *Export Report Data to File* window will open.

7. Select **Export** in the *Export Report Data to File* window.

⇒ The *Save file to CSV File:* window will open with the *File name* field populated as “LatestIBRSum.csv” (see figure below).

**NOTE:** If no data is generated, the file must still be exported and saved.

8. Navigate in the *Save file to CSV File:* window to the folder you created for your pavement asset management plan materials (see figure below).

9. Select **Save** (see figure below).

⇒ A window will appear confirming the file export location.

10. Select **OK**.

Reviewing the eight export files

All eight files should be included and visible in a single folder (see figure below).
Entering data into the Excel workbook

The pavement asset management plan Excel workbook (i.e., DataMacro_pavementAMP_v2019.xlsx) allows you to enter your agency’s pavement data, which will subsequently populate the Word template (i.e., pavementAMP.docm) that you will personalize for your agency’s pavement asset management plan. This pavement asset management plan workbook processes your pavement asset data into a Word document template.

Using the XLSM file for the first time

You will see a security warning when you open a macro-enabled Microsoft Office file for the first time. If this file is from a trusted source, select Enable Content (see figure below).

If you do not have the Word template and/or the .csv files in the same folder as the “Datamacro_pavementAMP_v2019.xlsm” folder, an error box will appear (see figure below).
Welcome Worksheet

NOTE: When you open the pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.xlsm), you will be greeted with a workbook orientation in the Instructions worksheet. Please read the entire sheet before beginning. Then:

1. Select Let’s Get Started (see figure below).

⇒ A dialogue box will open and will ask you to identify your agency as a county jurisdiction or city jurisdiction (see figure below).
2. Select **Yes** or **No** to answer “Are you a COUNTY jurisdiction?” (see figure above).

**NOTE:** If you select Yes to the dialogue box “Are you a COUNTY jurisdiction?”, a dialogue box will open that will indicate you are being classified as a county jurisdiction (see figures below). If this is not correct, exit the workbook without saving and re-open it.

**NOTE:** If you select No to the dialogue box “Are you a COUNTY jurisdiction?” a dialogue box will open that will indicate you are being classified as a city jurisdiction (see figures below). If this is not correct, exit the workbook without saving and re-open it.

† You will automatically proceed to the *Questionnaire* worksheet.

**Questionnaire Worksheet**

**NOTE:** The *Questionnaire* worksheet requires your response to several questions that will help tailor your asset management plan content.

**NOTE:** The *Questionnaire* worksheet and several of the following worksheets have been protected in order to provide guidance in modifying only the necessary cells. Throughout this workbook, heading rows should not be altered; altering heading rows will prevent the data from transferring into the Word template.

1. Enter your answers in Column C to the questions in Column 3 (see figure below).

**NOTE:** You can only enter or delete content in green and red cells in Column C. Column A (grey cells) contain Word tags, Column B (white cells) contains the questions, Column D (white cells) contains answer prompts and/or examples to make sure you format responses correctly, and Column F contains preview text that will update to illustrate how the answer will be reflected within the context of the asset management plan (see figure below).
**Note**: Some green cells in column C are dropdown lists (see figure below). These cells are marked in Column D – the notes column – with `<DROPDOWN>`. If none of the listed answers appropriately reflect your agency’s situation, select the blank entry in the dropdown list and then type your answer into the green cell. Please note that in some cases, this is discouraged.
**NOTE:** Some green cells in column C are checklists (see figure below). Select all boxes that are appropriate to your agency.

**NOTE:** Some cells in column C are grey and locked (not editable). These cells contain information from the Roadsoft data files.

2. In cell C40, select either **NCPP** or **Roadsoft** based upon your agency’s modelling/forecasting method (see figure below).
Note: You must make a selection for your modelling/forecasting method in cell C40 in order to continue using the workbook; a warning dialogue box will open if a selection is not made (see figure below).

A dialogue box will open indicating your selection as either NCPP or Roadsoft and indicating that the pavement asset management plan workbook has had a subsequent table been formatted according to that selection (see figures below).

3. Select OK.

**NOTE:** If you made an incorrect modelling/forecasting selection, select the other option in cell C40 to change your choice. A dialogue box will open asking you to confirm your new selection (see figures below).

4. Review your responses in the green cells, and select **Save** in order to save your work before continuing.
NOTE: It is recommended that you save your work before selecting continuing (see figure below).

5. Select the **Step 2: Proceed to userdata & Charts tabs** button at the top of the **Questionnaire** worksheet (see figure below).

![Image of Excel worksheet](image)

**NOTE:** The **Step 2: Proceed to userdata & Charts tabs** button will not be selectable until cells C4, C5, C15, C18, and C19 are filled and cell C40 has been answered (i.e., a modelling/forecasting method has been selected). Cells C18 and C19 will auto-populate after selecting a jurisdiction; these should not be changed manually at this time because identifying as a county or city jurisdiction upon initialization of the workbook formats other areas of the workbook and output of the data according to the originally-made identification.

◊ The workbook will import data from the .csv Roadsoft export files and format worksheets; when complete, you will advance to the **userdata1** worksheet automatically.

**NOTE:** This process is marked by a rapid succession of worksheet transitions. This is normal and indicates that the process is working as intended.
userdata1, userdata2, and userdata3 Worksheets

**NOTE:** The *userdata1*, *userdata2*, and *userdata3* worksheets require your proposed pavement asset management plan information with regards to your agency’s modelling/forecasting format.

**NOTE:** The *userdata1*, *userdata2*, and *userdata3* worksheets have been protected in order to provide guidance in modifying only the necessary cells.

1. Fill in the *userdata1* sheet

   **NOTE:** The *userdata1* sheet differs depending on whether your agency uses the NCPP or the Roadsoft modelling/forecasting method. Follow the instruction below a. **NCPP modelling/forecasting method** if you are using the NCPP method, or b. **Roadsoft modelling/forecasting method** if you are using the Roadsoft method.

   a. **NCPP modelling/forecasting method**

   Fill out all green cells on the *userdata1* worksheet with the treatment history, planned projects, and additional work necessary to overcome a deficit (if applicable) for your agency’s network 1 and network 2 road assets (see figure below).
b. Roadsoft modelling/forecasting method

Fill out all green cells on the *userdata1* worksheet with the treatment history, pavement condition forecast, and additional work necessary to overcome a deficit (if applicable) for your agency’s network 1 and network 2 road assets (see figure below).

**NOTE:** The years of life and trigger-reset data is modifiable to reflect your agency’s circumstances.

2. Review all information entered on the *userdata1* worksheet, and select **Save** to save your work before continuing.

3. Select **Proceed to userdata2 tab** (see figure below).
You will advance to the *userdata2* worksheet. A dialogue box will open informing you of the two options for displaying data on the network graphs; you will need to make a selection between displaying data per year or displaying data in 2- and 3-year groupings before proceeding to *userdata3* (see figure below and refer to step 6 below for more detail).

4. Select **OK**.

5. Fill in the *userdata2* worksheet’s green cells with forecasted trends and goals data for your agency’s network 1 and network 2 road assets (see figure below).

![Microsoft Excel](image1.png)

**NOTE:** The historic data is automatically populated based on your .csv Roadsoft export files. The charts will update as information is entered into the green cells.

**NOTE:** You will need to scroll down to fill out all green cells for network 2.

**NOTE:** Projected trend and goal information entered for the 1-year graph in columns C through H will be replicated in the data fields for the 2- and 3-year graphs in columns AX through BC since the projected trend and goal information will remain the same regardless of how you choose to graph the historic data.
6. Review all information entered on the *userdata2* worksheet, and select **Save** to save your work before continuing.

7. Select either **Select 1-year Graphs & Proceed to userdata3 tab** or **Select 2- and 3- year Graphs & Proceed to userdata3 tab** based on your desired chart format (see figure below).

⇒ You will advance to the *userdata3* worksheet.
8. Fill in the *userdata3* worksheet’s green cells with forecasted trends and goals data for your agency’s unpaved road assets (see figure below).

9. Review all information entered on the *userdata3* worksheet, and select **Save** to save your work before continuing.

10. Select **Proceed to Charts tab** (see figure below).
You will advance to the *Charts* worksheet, and a dialogue box will open to prompt you to format the charts according to your agency’s preferences.

![Microsoft Excel dialogue box](image)

11. Select **OK**.

A dialogue box will open if you have other Microsoft Word or Excel documents open (see figure below).

![Figure showing dialogue box](image)

12. Select **Yes** to enable Excel to close all other open Word and Excel documents automatically (see figure above).

OR: Select **No** to return to the *userdata3* worksheet and save and close all other open Word and Excel documents manually; then, repeat steps 10 through 12, selecting **Yes** in step 12.

13. Proceed with formatting the charts in the *Charts* worksheet according to your preferences.
Charts Worksheet

1. Review the Charts worksheet and format the charts as desired.

**NOTE:** Certain charts will be unavailable depending on whether your agency is a county or city jurisdiction. However, the Charts worksheet has no difference depending on whether your agency uses the NCPP or Roadsoft modelling/forecasting method.

![Charts Worksheet Image]

**NOTE:** The data in these charts is populated by your .csv Roadsoft export file and your answers in the userdata1, userdata2, and userdata3 worksheets. Any Roadsoft data errors or any errors in response on the aforementioned worksheets will be reflected in these charts.

2. Select **Save** to save your work before continuing.

3. Select **Step 3: Proceed to Word document** (see figure below).
NOTE: There are also three buttons on the top right of the Charts worksheet labeled Step 3a: Locate compliance plan (CP) template, Step 3b: Export CP charts & format template, and Step 3c: Build CSV for CP (see figure below). These buttons are for use in creating a compliance plan for the PA325 requirements. For more information, please refer to the Instruction Guide for the Compliance Plan Template. For creating a pavement asset management plan, only use Step 3: Proceed to Word document.

This will create and open a new Word document based on the pavementAMP_v2019.docm template. This new Word document will be saved in the same folder as the pavement asset management plan workbook, and will have your agency’s abbreviated name as part of the document’s file name.
Completing the Word template

The pavement asset management plan Word template (i.e., pavementAMP_v2019.docm) is automatically populated with content based on your responses and charts in the pavement asset management plan workbook (i.e., DataMacro_pavementAMP_v2019.docm). However, several places in the Word document still require your input and editing.

1. Address all orange-text field prompts/“Your Content Here” prompts.

   **NOTE:** `<#Orange text fields>` are placeholders for user-entered data. Each of these placeholders can be identified by its field formatting, its orange color, and its unique tagging “<#”. Each of these placeholders has a different prompt depending on the type of information to be input. An example of an orange-text field prompt is:

   `<# YOUR CONTENT HERE: Insert percent in ## format>`

   To address these prompts:

   a. Navigate to the orange-text field prompts or comments/“Your Content Here” prompts.

      i. Place your cursor on the cover page, then toggle to each prompt using the **F11** key on your keyboard.

      OR: Visually search the document for orange-text fields and/or “Your Content Here” prompts.

      OR: Select **Find** from the *Home* ribbon *Editing* group, and enter “<#” in the *Search document* input box. (Note: This will also find the missed auto-fills; see step 4, below).

   b. Fill in content/responses manually.

      **NOTE:** Some orange text field prompts are associated with dropdown selections for content/responses. The chosen dropdown selection or the manually-entered content/response should flow with the context of the paragraph or section.
2. Address all teal-commented optional sections (see figure below).

**NOTE:** Teal-commented optional sections signal entire sections that are optional and can be deleted based on your agency’s circumstances. These sections are placed in content controls. In many cases, you will have a choice between alternate teal-commented sections for the same entire section; you may delete one or all options for the entire section if it does not apply to your agency’s circumstances. Optional sections are accompanied by instructions in the teal-highlighted comment. An example of an optional section’s instructional comment is:

**Discuss the reconstruction treatments that apply to your agency’s methods used.**
To use/modify applicable content, right-click the content control and then select “Remove Control” to retain text; then, use/modify content.
To create new sub-sections, select the control handle and select Ctrl + C or use the Copy button in the Home ribbon Clipboard group; paste the copied content control at the bottom of the list.
To delete sub-sections, select the control handle and use your Delete key to delete content.

Scrolling over optional section content controls will shade the content control area in grey.

Scrolling over an optional section will show its content control and will shade the content control in grey (see figure above). At this point, you may address the teal-commented optional section in one of three ways:
a. **OPTION 1: Use and/or modify optional sections content:**

i. Right-click anywhere inside the content control.

⇒ A dropdown menu will appear.

ii. Select **Remove Content Control** (see figure below).

⇒ The content control is now removed and the text has merged with the body of the document. You may now edit this section as part of the body itself.

b. **OPTION 2: Create new sub-sections:**

i. Place cursor in optional section content control.

⇒ The content control frame and handle (upper left corner) will open (see figure above).
ii. Select the content control handle (see figure below).

iii. In the Home ribbon, select Copy from the Clipboard group to copy the chart/graph to the Windows clipboard.

OR: Right-click on the chart/graph; select Copy from the dropdown menu.

OR: Use the Ctrl + C keyboard shortcut.

iv. Place cursor at the end and outside the content-controlled area.

v. In the Home ribbon, select Paste from the Clipboard group to paste the chart/graph that was copied to the Windows clipboard.

OR: Right-click on the placeholder; select Paste from the dropdown menu.

OR: Use the Ctrl + V keyboard shortcut.

c. OPTION 3: Delete optional sections entirely:

i. Place cursor in optional section content control.

⇒ The content control frame and handle (upper left corner) will open.

ii. Select the content control handle (see figure above).
iii. Press the **Delete** key on your keyboard.

⇒ This removes the entire optional section.

3. Address missed auto-fills.

   a. Select **Find** in the *Home* ribbon *Editing* group.

      ⇒ The *Navigation* pane will open along the left side of the Microsoft Word window.

      i. Enter “<#” in the *Search document* input box in the *Navigation* pane.

      ii. Press **Enter** on your keyboard.

      ⇒ Any instances of “<#” will be found, and you will automatically advance to the first instance after your cursor’s current location.

      iii. Replace missed auto-fills with appropriate content.

      iv. Select **Next** to advance to the next instance of the auto-fill placeholder.

      OR

   b. Select **Replace** in the *Home* ribbon *Editing* group.

      ⇒ The *Find and Replace* dialogue box will open.

      i. Enter “<#” in the *Find what:* input box.

      ii. Select **Find Next**.

      ⇒ Any instance of the of “C#” will be found and you will automatically advance to the first instance after your cursor’s current location.

      iii. Replace any missed auto-fills with appropriate content.

      iv. Select **Find Next** to advance to the next instance of the auto-fill placeholder.

4. Address comments.
**NOTE:** Comments appear along the right side of the Word document. If you do not see comments, ensure that the markup dropdown menu in the *Review* ribbon *Tracking* group says “All Markup” or “Simple Markup”. If you select “Simple Markup”, you will need to select *Show Comments* in the *Comments* group (see figure below).

a. Delete comments when done by right-clicking on the comment and selecting *Delete Comment* from the dropdown menu (see figure below).
Customizing the Word Template

The pavement asset management plan should be customized to reflect your agency’s branding and asset management message.

Inserting a logo

1. Select the *picture* placeholder.

2. Select the icon in the center of the *picture* placeholder (see figure below).

⇒ The *Insert Pictures* dialogue box will open (see figure below).
3. Select **Browse** \(>\) in the *From a file* option row in the *Insert Pictures* dialogue box (see figure above).

⇒ The *Insert Picture* window will open (see figure below).

![Insert Picture Window](image)

4. Navigate to your desired image using the *Insert Picture* window (see figure above).

5. Select the image in the *Insert Picture* window, and then select **Insert** (see figure above).

⇒ The *Picture* placeholder will be replaced with the selected picture.

**Changing the color bar (Optional)**

1. Select the color bar on the cover (see figure below).

2. Select **Shape Fill** in the *Drawing Tools > Format* ribbon *Shape Styles* group (see figure below).

3. Select a color from the dropdown menu or select **More Fill Colors…** for additional choices (see figure below).
Changing color of Cover and Heading 1 Styles (Optional)

1. Select the expansion arrow for the Home ribbon Styles group (see figure below).

Arial

The Styles pane will appear on the right side of the Microsoft Office window.

2. Hover over the Cover or Heading 1 style. DO NOT select the style otherwise you will apply it to the text where your in-text cursor is positioned.

Arial

A dropdown arrow will appear on the right side of the listed style.
3. Select the dropdown arrow.

4. Select **Modify…** from the dropdown list (see figure below).

5. Select the dropdown arrow next to the color swatch (see figure below).

6. Select a color from the dropdown menu or select **More Fill Colors…** for additional choices (see figure below).

 Gaga The **Modify Style** window will open (see figure below).
7. Select OK.
Inserting charts (manual procedure)
You may also choose to add Excel charts or graphs manually to your pavement asset management plan Word document (i.e., pavementAMP_v2019.docm). To insert Microsoft Excel charts/graphs into the Word document:

1. In the workbook, select a chart/graph (see figure below).

![Chart Figure]

2. In the Excel workbook’s Home tab, select Copy from the Clipboard group to copy the chart/graph to the Windows clipboard.
   
   OR: Right-click on the chart/graph; select Copy from the dropdown menu.
   
   OR: Use the Ctrl + C keyboard shortcut.

3. In the pavement asset management plan Word template (i.e., pavementAMP_v2019.docm), place cursor at the position in the document where the chart or graph should be inserted.
   
   NOTE: If your pavement asset management plan Word template was not open before you started this procedure, you may open it now.

4. In the Word document’s Home tab, select Paste from the Clipboard group to paste the chart/graph that was copied to the Windows clipboard.
   
   OR: Right-click where your cursor is positioned, and select Paste from the dropdown menu.
   
   OR: Use the Ctrl+V keyboard shortcut.

Inserting images
Maps (see instruction in the section Creating map images from Roadsoft, below) and other images will help communicate your inventory of assets and your asset management goals.

NOTE: The procedure for creating maps in Roadsoft, exporting them as PDFs, and saving them as image files is detailed below.

To insert an image into the Word template:

1. Place cursor where you desire to insert an image.
2. Select **Pictures** in the *Insert* ribbon *Illustrations* group.

![Insert Picture window](image1)

⇒ The *Insert Picture* window will open (see figure below).

![Insert Picture window](image2)

3. Navigate to your desired image using the *Insert Picture* window; select the image and then select **Insert** (see figure above).

⇒ The picture will insert into the Word template.

4. Adjust by selecting the image and using **Wrap Text** option in the *Picture Tools > Format* ribbon (see figure below).

![Adjust image](image3)
Creating map images from Roadsoft

The pavement asset management plan Word template has several map images including figure 16 – inventory of pavement assets and figures 44 through 50 – pavement assets’ planned projects, and figure 54 – critical links in the road and bridge network. The following procedures detail the creation of each of these maps in Roadsoft and exporting them PDF files; an additional procedure explains the process of saving a PDF file as an image. The preceding section (above)—Inserting content into the pavement asset management plan Word Template—details the procedure for inserting images into a Word document.

Creating image for 1. Pavement Assets > Inventory of Assets (Figure 16)

1. Display roads according to rating.

   a. Select **Show Legend Window** ( ) in the **Map tool options** bar.

      ⇒ The **Road Legend** window will open (see figure below).

   b. Select **Open Legend Builder** ( ) in the **Road Legend** window (see figure below).

      ⇒ The **Legend Builder** window will open (see figure below).
c. Choose the **Good/Fair/Poor** field from the *Legend Field* dropdown list (see figure above).

d. Move the good, fair, and poor rated road values down to the *Query* box of the *Legend Builder* window.

   i. Highlight good, fair and poor unique values by selecting the first value (e.g., Good), holding down the **Alt** key on your keyboard, and selecting the subsequent unique values (e.g., Fair and Poor).

   ii. Select *Add Selected Unique Value(s)*.

 e. Select one condition *Query* value in the *Items* list.

 f. Adjust color and font size of the selected value using *Feature* and *Outline* in the *Item Properties* box (see figure below).

 g. Select *Apply Property to All Items* to apply adjusted color and font size to all *Query* items (see figure below).

   The *Apply Selected Property* dialogue box will open (see figure below).

 h. Select **Yes** in the *Apply Selected Property* dialogue box (see figure above).

 i. Select **Apply** in the bottom right of the *Legend Builder* window once the legend settings are correct.
The Road Legend window will display the applied legends (see figure below).

2. Add an unpaved road filter.
   a. Select Filter (Filter) in the Map tool options bar.
   b. Select Apply Saved Filter as Selection… from the Filter dropdown list.
   c. From the list of filters, apply both the city and county unpaved roads filters (see figure below).
   d. Select OK.
The filters will be applied.

e. Select File from the main menu, and select Export/Upload >.

f. Select Export Layer to File from the Export/Upload > flyout menu (see figure below).

The Export Road to Shapefile window will open (see figure below).

g. Select an Export Path (e.g., folder where you are storing your materials for your pavement asset management plan) and enter a File Name (e.g., unpavedroadlayer) (see figure above).

h. Import the shape file as a layer.
i. Right-click on **Road** from the *Map Layers* window (see figure below).

![Map Layers window](image1.png)

ii. Select **Add Layer** from the flyout menu (see figure above).

⇒ The *Add Map Layer* window will open (see figure below).

![Add Map Layer window](image2.png)

iii. Select the **External Layer** tab in the *Add Map Layer* window (see figure above).

iv. Browse for the exported shape file using the *Path* browse button (see figure above).

⇒ The *Select external file to add to the map* window will open (see figure below).

![Select external file to add to the map window](image3.png)

v. Navigate in the *Select external file to add to the map* window to the shape file exported in step 1, select the shape file, and select **Open**. (see figure below).
vi. Select **OK** in the *Add Map Layer* window.

⇒ The shape file will be added as a *Line Layer* in the *Map Layers* window (see figure below).

![Image](image1.png)

i. Right-click on the **Road** category once again (see figure above).

j. Select **Layer Properties** (elope).

⇒ The *Road Layer Properties* window will open (see figure below).

k. Select the **Legend** tab of the *Road Layer Properties* window (see figure below).

l. Adjust color and font size of the roads in the unpaved road layer (see figure below).

m. Select **Apply** (see figure below).

n. Ensure that both the shape layer (e.g., unpavedroadlayer) and the **Road** layer are selected in the *Line Layers* group of the *Map Layers* window; de-select the **Bridge** and **Intersection** layers of the *Point Layers* group.
3. Print the map as a PDF.

   a. When the map is ready, select **File** from the main menu (see figure below).

   b. Select **Print Current Map View** from the **File** menu (see figure below).

   ⊳ The *Map Print Setup* window will open (see figure below).
c. Enter desired label information into the *Title* and *Subtitle* input boxes, and adjust the *Scalebar Units* and *legend* as desired (see figure above).

d. Select **Print Map** (see figure above).

⇒ The Windows *Print* window will open (see figure below).

![Windows Print Window](image.png)

e. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

f. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

g. Navigate in the *Save Print Output As* window to the desired folder containing pavement asset management plan materials, enter a descriptive file name in the *File name* input box (e.g., `pavementAMP_figure1`), and select **Save**.
Creating image for 1. Pavement Assets > Planned Projects (Figures 44 – 50)

**NOTE:** The process detailed by the following instruction steps must be repeated for each road asset type (paved or unpaved) and for each year or year range to create figures 44 through 50.

1. View projects.
   
   a. Select **Show Legend Window** ( ) in the Map tool options bar.

   ⇒ The Road Legend window will open (see figure below).

   ![Legend Builder Window](image)

   b. Select **Open Legend Builder** ( ) in the Road Legend window (see figure above).

   ⇒ The Legend Builder window will open (see figure above).

   c. Select **Scheduled Maintenance Year** from the Legend Field dropdown box in the Legend Builder window (see figure above).
Relevant unique values will populate the *Unique Values* box (see figure below).

![Legend Builder window](image)

**d.** Select a year or span of years in the *Unique Values* box by clicking the first year, holding down the **Shift** key, and then clicking the last year in the range (see figure below).

**NOTE:** Since the pavement asset management plan is looking forward at the project you plan to do on your network, the selected span of years should begin during or after the publication year of your pavement asset management plan and include the subsequent years corresponding to the subsequent years covered in your pavement asset management plan.

⇒ All the selected years should be highlighted in blue.

**e.** Select **Add Selected Unique Value(s)** in the *Unique Values* box of the **Legend Builder** window (see figure above).

**NOTE:** The years should appear in the *Items* box (lower left).

**NOTE:** If any other values are listed in the *Items* box, these values should be deleted so that only the desired project years are listed (see figure below).

**f.** Select one year Query item in the *Items* list.
g. Adjust color and font size of the selected item using *Feature* and *Outline* in the *Item Properties* box (see figure below).

h. Select **Apply Property to All Items** to apply adjusted color and font size to all Query items (see figure below).

i. The *Apply Selected Property* dialogue box will open (see figure below).

j. Select **Yes** in the *Apply Selected Property* dialogue box (see figure above).

k. Select **Apply** in the bottom right of the *Legend Builder* window once the legend settings are correct.

⇒ The *Road Legend* window will display the applied legends (see figure below).
1. Ensure that the **Road** layer is selected in the *Line Layers* group of the *Map Layers* window; de-select the **Bridge** and **Intersection** layers of the *Point Layers* group (see figure above).

2. Create a new project.

   a. In the *Map* window, select **Road Segment** in the *Map tool options* bar (see figure below).

   ![Map window with selected Road Segment](image)

   b. Select the segment(s) of road on the map where the project will take place (see figure above).

      ⇒ Selected segment(s) will be highlighted.

   c. Select the **Projects** in the *Map tool options* bar (see figure above).

   d. Select **Add Project Using Selection…** in the *Projects* dropdown menu.

      ⇒ The *Add Project* window will open (see figure below).
e. Fill out Project Information fields (i.e., Location, Project Number/OD, Surface Subtype, Life Expectancy, Estimated Costs, Total Costs, Start Date, status, Completion/Open To Traffic Date, Reactionary Project, Warranty Project, Description, Source of Funds, Memo).

**NOTE:** As long as the Start Date field data falls within the selected span of years (see step 1.c), the road segments will be displayed with the same color as the other road projects within the same span of years.

f. Select Save.

3. Print the map as a PDF.

a. When the map is ready, select **File** from the main menu (see figure below).
b. Select **Print Current Map View** from the *File* menu (see figure below).

![Print Current Map View](image1)

⇒ The *Map Print Setup* window will open (see figure below).

![Map Print Setup](image2)

c. Enter desired label information into the *Title* and *Subtitle* input boxes, and adjust the *Scalebar Units* and *legend* as desired (see figure above).

d. Select **Print Map** (see figure above).

⇒ The Windows *Print* window will open (see figure below).

![Windows Print](image3)
e. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

f. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

g. Navigate in the *Save Print Output As* window to the desired folder containing pavement asset management plan materials, enter a descriptive file name in the *File name* input box (e.g., *pavementAMP_figure6*), and select **Save**.

---

**Creating image for 3. Risk of Failure Analysis (Figure 54)**

1. Select **Road** in the *Map Layers* window.

2. Select **Road Segment** in the *Map tool options* bar (see figure below).

3. In the *Map* window, select a segment or multiple segments of road (see figure below).

**NOTE:** Hold down the **Ctrl** on your keyboard when selecting with the mouse in order to make multiple selections, or hold down the **Alt** key on your keyboard when selecting with the mouse in order to de-select a segment.

4. Right-click on any of the selected segments (see figure above).
5. Select **Save Selection as Filter**… from the dropdown list (see figure below).

![Dropdown List](image)

**⇒** The **Save Selection as Filter** window will open (see figure below).

![Save Selection as Filter Window](image)

6. Enter a name in the **Name** input box for filter.

7. If a risk group already exists, select risk group from the **Group** dropdown list.

   OR: If a risk group does not exist, type in the name of a new risk group in the **Group** field.

8. Right-click on a selected high-risk segment in the **Map** window.

9. Select **View Module**… from the dropdown list.
10. Select the **User-Defined** tab located on the left side of the *Road Module* tab (see figure above).

⇒ The *User-Defined* window will display (see figure below).

11. Select the plus sign to the left of the first user-defined field, “User Def 4” (see figure above).

⇒ This will expand the field options for that user defined field.

12. Select the **Change Label**… option associated with the *User Def 4* field options (see figure above).
13. Enter a name for the user-defined field in the input box: “Risk” (see figure above).

14. Select OK.

15. Select the Add/Edit Risk… option associated with the Risk field options.

16. Select Add (see figure above).

17. Enter a new name in the Description input field and an abbreviation in the Abbreviation input field for the new high-risk section.

18. Select Save.

**NOTE:** Save these options for the “Risk” user-defined field before creating values for every other high-risk section.
19. Select the X in the top right corner of the View/Edit Lookup/Defaults window to close the window and return to the map when finished.

 proclaim that User-defined values will now be added to the Road Module.

**NOTE:** These newly-added user-defined values still need to be applied to the appropriate segments. The Multi-edit tool is used to accomplish this.

20. Select the Map tab.

21. Right-click on the map.

22. Select Apply Saved Filter as Selection… from the dropdown menu.

23. Use the Group dropdown to locate the Risk group.

24. Select OK.

25. Select View Module (View Module) in the Map tool options bar.

26. Select Multi-edit (Multi-edit) in the Road Module tab (see figure below).

27. Select All Segments from the dropdown menu.
The Road Multi-edit window will open (see figure below).

28. Select **ALL Selected Segments** from the PR dropdown list.

29. Select **User-Defined** from the Inventory section of the window (see figure below).
30. Select Risk in the User Defined Fields box, and use the dropdown list at the right side of the field to select the first segment.

31. Repeat this steps 29 and 30 for each of the segments.

32. Apply legends to high-risk segments.

   a. Select Show Legend Window ( ) in the Map tool options bar.

   ⇒ The Road Legend window will open (see figure below).

   b. Select Open Legend Builder ( ) in the Road Legend window (see figure above).

   ⇒ The Legend Builder window will open (see figure above).

   c. Select Risk from the Legend Field dropdown box in the Legend Builder window (see figure above).

   ⇒ Relevant unique values will populate the Unique Values box.

   d. Select the desired segments.

   ⇒ All the selected segments should be highlighted in blue.

   e. Select Add Selected Unique Value(s) ( ) in the Unique Values box of the Legend Builder window.

   f. Values will be added to the Query in the Items box.

   g. Select the first Query item in the Items list.

   h. Adjust the color and font size using Feature and Outline in the Item Properties box.

   i. Select Apply Property to All Items to apply adjusted color and font size to all Query items.

OR

Repeat steps 32g and 32h for each Query item to create a unique legend for each item.
j. Select **Apply**.

33. Print the map as a PDF.

a. When the map is ready, select **File** from the main menu (see figure below).

b. Select **Print Current Map View** from the **File** menu (see figure below).

![Map Print Setup window](image)

⇒ The **Map Print Setup** window will open (see figure below).

c. Enter desired label information into the **Title** and **Subtitle** input boxes, and adjust the **Scalebar Units** and **legend** as desired (see figure above).

d. Select **Print Map** (see figure above).
The Windows Print window will open (see figure below).

![Print Window](image)

- Select **Microsoft Print to PDF** from the Print window (see figure above).
- Select **Print** (see figure above).
- The Save Print Output As window will open.
- Navigate in the Save Print Output As window to the desired folder containing pavement asset management plan materials, enter a descriptive file name in the File name input box (e.g., `pavementAMP_figure54`), and select **Save**.

**Creating images from PDF files**

To create images from the four PDF Roadsoft map files, you will need a PDF reader/writer software program that allows you to save the PDF as an image. An example of this software is Adobe Acrobat.

1. Open each PDF map in the PDF software program.
2. Select **File** from the main menu.
3. Select **Save As** from the **File** menu.
4. Change **Save as type** to an image format (e.g., JPG, PNG, GIF, TIF).

Note: It is important to ensure that the save location for the file is the same folder where you are saving all of your pavement asset management plan materials.
Note: The file name should remain the same as the PDF file name, but the extension will change from “.pdf” to the file extension corresponding with your selected image format.

5. Select Save.

6. Follow the procedures (detailed above) for inserting images into your pavement asset management plan Word template.
Updating the Table of Contents, Table of Figures, and Table of Tables

1. Update Table of Contents
   
   a. Select the Contents field.

   **NOTE:** The Contents may also be titled Table of Contents.

   ⇒ The Contents will highlight in grey and the Contents menu bar will appear (see figure below).

   b. Select **Update Table** in the Contents menu bar (see figure above).

   OR: Right-click in the Contents field, and select **Update Field** from the dropdown menu (see figure below).
A dialogue box will open prompting you to select an update option (see figure below).

[Image: Dialogue box for updating Table of Contents]

- Select **Update entire table**, and then select **OK** (see figure above).

**NOTE:** If you select **Update page numbers only**, Word may not update the *Table of Contents* to reflect every added or removed section but only the new page numberscorresponding to existing sections. Selecting **Update entire table** will update all sections and page numbers.

- The *Table of Contents* will update to reflect the changes you have made to the document.

**NOTE:** If you make further changes to the Word document that involves adding or removing sections or changing page numbers, you will need to update the *Table of Contents* again to reflect these changes. The *Table of Contents* does not update automatically.
2. Update Table of Figures
   
a. Select the **Table of Figures** field.

   ⇒ The Table of Figures field will highlight in grey (see figure below).

![Figure showing Table of Figures field highlighted]

b. Right-click in the **Table of Figures** field, and select **Update Field** from the dropdown menu (see figure below).

![Figure showing Update Field option selected]
A dialogue box will open (see figure below).

![Update Table of Figures dialog box](image)

- Select **Update entire table**, then select **OK**.

**NOTE:** If you select **Update page numbers only**, Word may not update the *Table of Figures* to reflect every added or removed figure but only the new page numbers corresponding to existing figures. Selecting **Update entire table** will update all figures and page numbers.

- The *Table of Figures* will update to reflect the changes you have made to the document.

**NOTE:** If you make further changes to the Word document that involves adding or removing figures or changing page numbers, you will need to update the *Table of Figures* again to reflect these changes. The *Table of Figures* does not update automatically.

3. **Update Table of Tables**

**NOTE:** A *Table of Tables* will automatically merge into a preceding table and be deleted. Therefore, a *Table of Tables* should be created at the end of the entire document, copied, and pasted after the *Table of Figures*.

- Delete the *Table of Tables* in the current document, leaving the heading in place.

- Place your cursor at the very end of the document.

- Select **Insert Table of Figures** in the *References* ribbon *Captions* group.
The Table of Figures window will open (see figure below).

d. Select **Table** from the **Caption label** drop-down menu (see figure above).

e. Select **OK**.

f. Highlight the inserted **Table of Tables**.

g. Drag and drop your selection below the **Table of Tables** heading (see figure below).
Inserting Appendixes

To create a pavement asset management plan document with appendixes as a single file, save the pavement asset management plan Word template and any other associated files as PDFs. Then, using a PDF editing software program, merge the PDFs into a single PDF.

To save a Word document as a PDF:

1. Select **File** in the ribbon menu.

   ![Ribbon Menu with File Option Selected]

2. Select **Save as Adobe PDF** in the **File** sidebar menu (see figure below).

   ![File Sidebar Menu with Save as Adobe PDF Option Selected]

   OR: Select **Print** in the **File** sidebar menu (see figure above).

   - The Windows **Print** window will open (see figure below).
a. Select **Microsoft Print to PDF** from the *Print* window (see figure above).

b. Select **Print** (see figure above).

⇒ The *Save Print Output As* window will open.

c. Navigate in the *Save Print Output As* window to the desired folder containing compliance plan materials, enter a descriptive file name in the *File name* input box (e.g., `pavementAMP_2019` or `pavementAMP-appendix1_2019`), and select **Save**.

OR: In the *Home* ribbon, select **Create and Share Adobe PDF** in the *Adobe Acrobat* group (see figure below).

3. Once all necessary files have been saved as a PDF, proceed with using a PDF editor to compile all necessary PDFs into a single PDF.
Updating in Future Years

1. Complete the required Roadsoft exports as before and complete the steps in the Excel document.

2. An original template must be saved for requested form the CTT with the link data.

3. Once an original template is available, the transfer can be completed from Excel to the Word template.